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Overview

Have you joined in the fun and excitement of downloading music files from the Internet? Have you 
collected hundreds of music files? If so, the big question is... How much of your precious time will you 
spend organizing those music files?
The answer is "very little time" with the award-winning file management tool, Tag&Rename.
Tag&Rename is a handy management utility designed for mp3, wma, ogg, mp4 (m4a, m4p) and many 
other music files. With Tag&Rename you can quickly and easily rename your music collection using the 
embedded tag data within music files, write new or edit existing tag information, create tags based on 
file names, get song information from the freedb server, or import it from the amazon.com. Tag&Rename 
supports all popular tag standards used by software and hardware players. This program is a very useful 
playlist editor with recursive subfolder support and a unique file list which show all your files in a real 
folder structure.
Tag&Rename is the only music organizer and tag editor which supports all popular file formats:

• .mp3 - ID3v1, ID3v1.1, ID3v2.2, ID3v2.3 and ID3v2.4 tags 
• .wma, .asf and .wmv (Windows Media) - Windows Media tags 
• .m4a, .m4b (Apple iTunes aac and lossless audio files), .m4p (protected files from Apple Music 

Store), .mp4 - iTunes tags 
• .ogg, .flac and .spx - Vorbis Comments 
• .mpc (MusePack), .ape (Monkey's Audio), .ofr (Optim Frog), .wv (Wav Pack) and .tta (True 

Audio) - APEv1 and APEv2 tags 
• .wav – ID3v2 tag in 'id3 ' RIFF chank 
• Tag&Rename provides full support for the following tag frames in all supported music formats: 

Artist, Album, Title, Year, Genre, Comment, Composer, Original Artist, Copyright, URL, Encoded 
by, Track #, Disc #, Rating, Mood, BPM, Part of a compilation, Cover art, Lyrics, Album Artist, 
Conductor, Lyricist, Original Lyricist, Label, Remixed by, Radio station name, Audio file 
information web page, Artist web page, Audio source web page, Radio station web page, Buy CD 
web page, ISRC #, Catalog #. 

Key features:
• Rename music files according to tag information: Easily rename files using templates 

individually or whole directories at a time, preview changes before renaming or undo the last 
renaming process, rename the folder (including subfolders) containing your music files, and 
manually edit files and folders names. 

• Multi-file or manual tag editors: Edit tags for multiple or single files, add cover art to all 
album files with a few clicks, and fill in tag fields using the file name. 

• Freedb support: Get tag information for full music albums automatically in seconds using the 
freedb Internet server. 

• Amazon/tracktype.org support: Search and import album information and cover art from the 
amazon.com or tracktype.org server to file tags (all Amazon servers supported: amazon.com, 
amazon.co.uk, amazon.de, amazon.fr, amazon.ca and amazon.jp). 

• Text case conversion functions: Convert case or capitalize the first letter of each word within 
file names or tags. 

• Tags synchronization wizard: Synchronize between ID3v1 and ID3v2 tag data. 
• Export wizard: Export your music information into any format - csv, xml, html and tab delimited 

text. 
• Full Unicode support: Supported on Windows NT/2000/XP/2003/Vista. 
• Rename music files folder: Rename according to tag information. 
• Full support for file drag and drop: Drag and drop file just like in Windows Explorer. 
• M3u play lists: Create m3u playlists (or m3u8 UT8 encoded Unicode playlists) using the unique 

Quick Save Playlist feature. 
• Play music files: Listen to your music files using your favorite music player. 
• Windows Explorer shell extensions: Add Tag&Rename to the context menu of MS Explorer 

so that you can access it faster (right-click mouse) from the MS File Manager. 
Tag&Rename is very easy to use and highly configurable. In addition, it has helpful notes and 
descriptions of menu commands built into the interface to help speed up your understanding and use of 
the program.
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What's new in this version? 

Tag&Rename v3.5 (25/02/2009):
• minor bugs fixed 

Tag&Rename v3.5 rc 3 (18/02/2009):

• fixed bug in mp4 parser 
• minor bugs fixed 

Tag&Rename v3.5 rc 2 (13/02/2009):

• added "Use check boxes to select files" option (improved check box files selection function) 
• added "Don't show splash screen on program startup" in advanced options 
• added "Use Vista style files selection in files list" in advanced options 
• added support of big sized cover art in wma/asf files 
• improved Album Artist tag frame support in ogg, flac and ape files 
• improved writing speed of wma/asf files 
• "Part of a compilation" data can be exported to cvs/xml now 
• minor interface improvements 
• fixed minor bug in shell extension 
• fixed bug in wav tags writing 
• minor bugs fixed 

Tag&Rename v3.5 rc 1 (21/10/2008):

• added "Replace spaces with underscores" option in rename actions 
• "Lyricist" and "File Extension" columns added to main files list 
• in Amazon import added support for song titles in "Title - Orig. Artist" format 
• speedup reading files information 
• improved drag&drop support 
• improved mp4 files parser 
• minor bugs fixed 

Tag&Rename v3.5 beta 5 (30/08/2008):

• added option: "Set "Album Artist" to "Various Artists" when "Part of a compilation" checked" 
• "Add "folder.jpg" to Files Tag" and "Extract "folder.jpg" from Files Tag" can be moved to toolbars 

now 
• minor improvements 
• minor bugs fixed 

Tag&Rename v3.5 beta 4 (20/08/2008):

• folders in file list now also sorted according to sort column 
• new columns add to main files list: Grouping, Subtitle, Release Time 
• minor bugs fixed 

Tag&Rename v3.5 beta 3 (18/08/2008):

• added new tags frames support: Grouping, Subtitle, Release Time, Podcast, Podcast Category, 
Podcast Description, Podcast ID, Podcast URL, Music/Video Kind, Show Title, Episode ID, Season 
Number, Episode Number 

• added Lyricist, Mood, Label and Remixed by variables in rename/file name to tag functions 
• minor bugs fixed 
• fixed bug in 32 bit shell extension 
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Tag&Rename v3.5 beta 2 (08/08/2008):

• minor bugs fixed 

Tag&Rename v3.5 beta 1 (06/08/2008):

• music files reading speed improved in many times 
• many speed improvements 
• main window toolbars redesigned 
• tolbars and shortcuts can be customized now 
• full Windows Vista support including program dialogs, messages, etc. 
• groups of files/titles in Amazon "Album Information" window can be moved/dragged now 
• improved drag and drop operations in main files list 
• shell extion now work in 64 bit OS 
• cover art can be drag and droped from Firefox 3 window 
• a lot of changes and fixes 

For full program history see the Whatsnew.txt file in the Tag&Rename folder.
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Renaming files

With Tag&Rename you can quickly and easily rename your music files according to their tag information. 
It’s as simple as 1-2-3! Just open the folder containing files to rename, configure the rename options and 
click the Rename button.

To open a folder containing your music files, select it in the Tag&Rename folders tree. Now you are ready 
to begin renaming your favorite music files!

Note: The following functions are driven by pre-existing tag information. If files do not contain tag data, 
you cannot rename them with the Rename file option. Instead, you may use the Filename to tag 
option to generate tag data based on the file name. (See How to get tags from file name for more 
information.) Otherwise, you may manually enter the ID3 tag information using the multi-file or 
manual ID3 tag editor, using freedb, or Get album title from amazon.com, if you have the full 
album.

Rename files options:

 

Tag&Rename Rename Files tab.

File name mask - This is the main rename option where you may fully configure filenames using 
variables and/or any text. For example, if you key in the %1 - %3 - %2 variables (in that order) in the 
"File rename mask" box, it will produce filenames with "Artist - Album - Title.mp3". You will find the 
following Rename variables listed on the user interface for your convenience:

Rename variables

%1 Artist

%2 Title

%3 Album

%4 Year

%5 Genre

%6 Track #

%7 File name

%8 File number

%9 Comment

%0 Bitrate

%t Play time

%b BPM

%cp Composer

%aa Album Artist

%co Conductor

6

file:///D:/Work Files/Work Files/Projects/Working Projects/TagRename_v3.5/html/_html new/02.05 How to get album information from amazon.com.htm
file:///D:/Work Files/Work Files/Projects/Working Projects/TagRename_v3.5/html/_html new/02.04 How to get song information using freedb.htm
file:///D:/Work Files/Work Files/Projects/Working Projects/TagRename_v3.5/html/_html new/02.02 Editing tags.htm
file:///D:/Work Files/Work Files/Projects/Working Projects/TagRename_v3.5/html/_html new/02.02 Editing tags.htm
file:///D:/Work Files/Work Files/Projects/Working Projects/TagRename_v3.5/html/_html new/02.03 How to get tags from file names.htm
file:///D:/Work Files/Work Files/Projects/Working Projects/TagRename_v3.5/html/_html new/02.03 How to get tags from file names.htm


Tag&Rename 3.5 User Manual – March 1, 2009

%# Disc #

%rt Release Time

%md Mood

%lb Label

%rb Remixed by
 

Note: For easy typing your rename mask (variables), you may use the Mask Editor. Click the button 
next to the file name mask list to open it. With the Mask Editor you can easily create, preview and save 
your masks for future use.

Result preview – Here you can see real time preview results of the rename mask you defined.
Replace spaces by underscores – Check this box to generate file names like "Artist_-_Title.mp3".
Case – Checking this box enables the UPPERCASE, lowercase, Capitalize First Letter (of each word) or 
Capitalize first word functions.

Note: Keep in mind that you may substitute variables for any text you choose. If you want to create a 
folder structure, you may use "\" in the rename mask as in the example below: 

Rename mask: %1 - %2\%8 %2
Result: c:\mp3\Artist - Album\01 Title.mp3
 c:\mp3\Artist - Album\02 Title.mp3

Rename files buttons:
Test – Allows you to preview file name changes in a "before & after" split window before committing to 
the rename process.
Rename – Will rename selected files according to the selected options.
Undo – Will undo the last renaming process.
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Editing tags

There are two ways to edit tags: manually or multi-file.
To edit a tag manually, double-click a file in the file list and edit the tag in the pop-up window. The pop-
up window shows file information (bitrate, play time, etc.) and allows you to perform the following 
commands:

• Save changes of selected files 
• Cancel command 
• Remove tag from selected file 
• Save changes to selected file and edit next or previous file 

   

Tag&Rename Manual Tag Editor window.

Under the Multi File Tag Editor (Ctrl+F4) tab you can easily write, create or remove tags from 
selected files. Click on the white boxes (to the left of the tag field names) that you want to edit, fill-in the 
appropriate information and click the Save Tags button. You may also enable one of the case functions, 
which will convert all tag fields to your case preference.

 

Tag&Rename Multi File Tag Editor options tab.

Note: To edit all additional supported tag fields in selected files, click on the Edit All Supported Tag 
Fields button in the Multi File Tag Editor (Ctrl+F4) or use the Ctrl+F5 hotkey.
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Tag&Rename All Supported Tag Fields in the Multi File Tag Editor.

Multi File Tag Editor buttons:
Save Tags – Save changes to selected files.
Remove Tags – Remove tag information from selected files. (This operation cannot be undone.)
Copy from Focused File – Click this button to copy tag information from the file with the focus to Multi 
File Tag Editor fields.
Edit All Supported Tag Fields – Edit all tag fields supported by Tag&Rename.
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How to get tags from file names

If you have files without tags, you can get them from file names containing information about the artist, 
title, etc. Under the Get Tags from File Name (Shift+F4) tab, configure the file name to the tag 
options and click the Write Tags button. 

File name to tag options:

 

Tag&Rename get tags from file name options tab.

File name mask - In this field you must provide the file mask variables. For instance, if your files are 
similar to the below examples..
01 Artist - Title.mp3
02 Artist - Title.mp3
03 Artist - Title.mp3
You may want to type in this file name mask: %6 %1 - %2

Rename files options:
File name variables

%1 Artist

%2 Title

%3 Album

%4 Year

%5 Genre

%6 Track #

%9 Comment

%b BPM

%cp Composer

%aa Album Artist

%co Conductor

%# Disc #

%rt Release Time

%md Mood

%lb Label

%rb Remixed by

%d Skip part of the file name
 

Note: If the folder name contains some track information, you may use the "\" symbol in the file name 
mask. For example, if your files are located in a folder with an "Artist - Album" name, you may use this 
file name mask: %1 - %3\%2

10



Tag&Rename 3.5 User Manual – March 1, 2009

Replace underscores with spaces – Check this box to convert underscores to spaces.
Case – Enables case functions from which you may select one.

Get tags from file names buttons: 
Preview – Allows you to preview tag changes before committing to the write tags process.
Write Tags – Click to write the tags of selected files.
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How to get song information using freedb

If you have full albums as music files without tags and you know in which order the tracks appear on the 
original CD, you may use the freedb functions. You must connect to the Internet for this function to work 
properly.

1. Connect your PC to the Internet. 
2. Select (or check if the Use check boxes to select files is enabled) files from a single album 

only. 
3. Sort selected files in the order they appear on the CD using the Move file up and Move file 

down functions, hotkeys (Alt + Up, Alt + Down), or drag and drop. (You can also use the 
Sort by file creation time function in the View menu.)

 

Tag&Rename file list with selected files from one album.

4. Click Get album titles from freedb. 
5. If Tag&Rename finds the album (usually in a manner of seconds), the album(s) information 

should appear in the Get Album Songs window. Now you need to select an album in that 
window and click the Get Titles button. This will load the selected album track titles so they 
appear in the Songs titles window. If they do, click the Write Tags button to transfer and save 
information to the files tag. 
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Album titles loaded from freedb.

Note: Should information only appear in the top window, click on the information and then click the Get 
Titles button. Now, click the Write Tags button once the song titles appear.
 
Note: The freedb uses a CD's original song order and track time as two parameters (among others) to 
retrieve song information. Tag&Rename attempts to emulate these parameters to get the song 
information from the freedb server. If ANY changes were made to the leading or trailing silence of MP3 
track times with a MP3 sound editor for example, then the album CANNOT be found using freedb.
 
Note: you can also setup what rename actions must be applied after album information will be written to 
tags. See also Using rename actions chapter. 

Tip: If every full album is stored in it's own folder, then you may use Get folder album titles from 
freedb function in file list folders popup menu. This will save a lot of time. (Don't forget to enable 
Search subfolders option in the Main Menu -> View)
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Tag&Rename file list with folder popup menu.

Keep in mind that freedb will only retrieve the album, artist, song and track number information.

Tip: If you do not know the song order of an album, you may use Get album information from 
amazon.com.
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How to get album information from amazon.com

If you have full albums without tags and you know the album title and author, you can use amazon.com 
to get the tag information you need. You must connect to the Internet for this function to work properly.

1. Connect your PC to the Internet. 
2. Select files from one album.

 

 

Tag&Rename file list with selected files from one album.

3. Click Get album titles from amazon.com. 
4. In the window that opens, fill in the Artist and Album fields (if not filled automatically), and 

select the amazon mirror you want to Search in. 
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5. Click the Search! Button.
 

 

Load Album Titles from Amazon window.

6. After Tag&Rename has found the albums you requested, select an album from the list and click 
the Get info! button.
 

 

Load Album Titles from Amazon window with search results.
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7. Sort files and titles using the move file Up and move file Down functions or drag and drop. 
8. Select the information you want to save. 
9. Click the Write Tags button. 

 

Album Information window with loaded albums.
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Tags synchronization wizard

With the Tags Synchronization Wizard, you can synchronize mp3 file information between ID3v1 and 
ID3v2 tags.
To synchronize tag information:

 

Tags synchronization Wizard window.

1. Select files that you want to update. 
2. Click the Tags Synchronization Wizard button in the Tag&Rename toolbar. 
3. Choose wizard options and click the Go button. 

Tags Synchronization Wizard options:
Wizard mode – Select the tag type that contains the correct information and which tag you want to 
update.
If tag already exists – Choose the option you prefer if an updated tag already exists in the file.
Case – Check the Case box if you want to use case options.

Note: In the unregistered version of Tag&Rename, this wizard processes only the first 10 selected files 
in the file list.
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Export wizard

With the Export Wizard, you can export your music library information to html, xml, csv or text and then 
print it or export it to any database.
To use the Export Wizard:

 

Export Wizard options.

1. Select the files you want to export. 
2. Click Export Wizard. 
3. Choose the wizard options you want and click the Go button. 

Export Wizard options:
Export templates – Select the export format.
Export information – Select the tags and file information you want to export. (These options are 
disabled when you export to html.)
Export file name – Choose a name for the file you will export to.
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ID3v2 tags tips

Tag&Rename provides full support for ID3v2 tags including support for ID3v2.2, ID3v2.3 and ID3v2.4 
(ANSI, Unicode and Unicode UTF8 encoded tags). Tag&Rename always writes ID3v2.3 tags because of 
compatibility with other software/hardware. 

ID3v2 tags benefits:

• No string-length limitations 
• Ability to add custom Genre fields 
• Cover art 
• Ability to save Unicode information into ID3v2 tags (see Program options -> Tags) 

Note: ID3v2 tags are stored in the beginning of the mp3 file. This is why it takes more time to write it 
the first time. (Tag&Rename needs to move all the file data.)

 
For more information about ID3v2 tags go to: http://www.id3.org/
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Tag&Rename tool bar

The following functions can be located on the toolbar. When you place your mouse pointer on a menu 
command, the status bar at the bottom of Tag&Rename displays a description of what that command 
does.
Note: you can cofigurate Tag&Rename toolbar to your needs by using Castomize Toolbar function 
from program main menu -> Options.

 

Tag&Rename main toolbars.

 
Select all files – selects all files in the files list

 
Select none – selects no files in the files list

 
Invert selection – inverts the selection of files in the fileslist

 

Select highlighted files – selects all highlighted files in the files list (work only when Use check 
boxes to select files is enabled)

 

Deselect highlighted files – selects no highlighted files in the files list (work only when Use 
check boxes to select files is enabled)

 
Refresh – refreshes the Tag&Rename file list

 

Find... – opens a standard find dialog to search for files in which tag information or the file name 
contains text you specify

 

Search subfolders – searches subfolders for music files (in the file list, you will see the folder 
structure)

 
Flat file list - the program file list shows only files and hides the actual folders structure

 

Expand all folders – expands all folders in the file list (only enabled when folders exist in the file 
list)

 

Collapse all folders – collapses all folders in file list (only enabled when folders exist in the file 
list)

 
Edit file tag – edit a tag in a file focused in the program file list

 

Edit file name – change a file name manually in the Edit file name pop-up window. 
Tag&Rename automatically adds the extension to the file name

 
Rename current folder – rename the current folder in the Folder rename pop-up window 
according to a file tag within the directory
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Tip: Rename current folder is handy if you have a full music album in a folder and the tags 
already include the artist and album information.

 
Play file – plays a music file on your default music player

 

Play selected files – generates a temporary playlist from selected files and plays it on your 
default music player

 
Move file down – move a file down in files list

 
Move file up – move a file up in files list

 

Save selected files to "*.m3u" playlist – name and save the playlist of selected files to the 
directory of your choice

 

Quick save playlist (selected files) - save the playlist of selected files (no naming option 
provided)

 

Save all files to "*.m3u" playlist – name and save the playlist of all files to the directory of 
your choice

 

Quick save playlist (all files) - save the playlist of all files (no naming option provided)

Tip for Quick save playlist options: Tag&Rename can save playlists to the current directory 
with a default file name of the artist and album using the highlighted or first such item within the 
directory music file tag information.

Select the Configuration option to change the default settings of the playlist name (artist & 
album) for all or selected files. For more information see the Playlists topic in Customize 
Tag&Rename.

 

Delete files – delete selected files. Tag&Rename sends the files to the Recycle Bin. Use the 
Restore feature of the Recycle Bin if you accidentally delete files

 
Options – see Customize Tag&Rename section

 
Get album titles from freedb – see How to get songs information using freedb section

 

Get album titles from www.amazon.com – see How to get album information from 
amazon.com section

 
Tags synchronization wizard – see Tags synchronization wizard section

 
Export wizard – see Export wizard section

 

Copy tag – copies a tag from a highlighted file so you can paste it into another file or group of 
files

 
Paste tag – paste a tag into a highlighted file

 
Paste tag to all selected files – paste a tag to all selected (checked) files
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View help – view the Tag&Rename help file

 
About Tag&Rename – view the About box

 
Format track numbers to x.

 
Format track numbers to 0x.

 
Format track numbers to 00x.

 
Format track numbers to xx/xx.

 
Format track numbers to xx.

 
Auto fill track numbers.
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Using filters

By using filters, you can show/hide files in the Tag&Rename file list according to its tag contents. To 
show the filter toolbar, select Filters in the Tag&Rename main menu. Then select View -> Toolbars. 
You can filter files by most tag frames information, tag existence, file name and "Low bitrate" (see also 
Low bitrate settings in File list topic).

 

Filters toolbar.

To filter files, select the field you want to Filter by from the list ("Artist" in the example), enter text to 
find ("a*" to find all artists starting with "a") and click the Filter! button. This will hide all files which 
don't comply with the filter condition. To show all the hidden (filtered) files, click the Show All button.

Here is some filter usage examples:

a* - find all texts starting with “a”

*text* - find all texts containing “text”

*text - find all texts ending with “text”

 

Result of filters usage.
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Using rename actions

With rename actions you can rename music files and it folder in one mouse click. At first you need to 
create new rename action by clicking Manage Actions button in Rename Actions toolbar. After this 
you will see Manage Actions window:

 

Manage Actions window.

Press Add Action button to add new action. Select this action and set Action name, File name mask 
and Folder name mask in it (if you only want to rename files, you don’t need to check and set Folder 
name mask).

Note: in rename actions masks you can’t create sub-folders while renaming, i.e. you can’t use “\” in 
rename masks.

 

Manage Actions window with one action.

In Manage Actions window you can add as many actions as you need. Press OK button after you added 
all actions. After this, you will see buttons in Rename Actions toolbar corresponding to every created 
action:
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Rename Actions toolbar with button Main corresponding to “Main” Action.

To run an action you need to select files in Tag&Rename file list and press action button in Rename 
Actions toolbar:

 

Main window with files selected in files list before we press Main action button.

 

Main window after we press Main action button (both files and folder renamed according to action 
settings).

Actions can be also applied to multiple folders. Here is an example:
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Before Main action applied.

 

After Main action applied (all selected files and folders renamed).

Actions also can be used in freedb.org and amazon.com import: you can set what action must be applied 
to album files after album data will be written to files tags.
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Program file list 

In the examples below, you can see additional information about the Tag&Rename file list:

 

Tag&Rename file list with Use check boxes to select files option disabled.

 

Tag&Rename file list with Use check boxes to select files option enabled.

All Tag&Rename file list features can be controlled in the File list and File list columns.
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Mask editor

Use the Mask Editor to easily create, preview and manage file and folder name masks. Click the Mask 
Editor button to the right of the File name mask box:

 

Mask Editor button.

Tip: You can sort saved masks in the Mask Editor by pressing Alt and using the Up or Down keys.

 

Tag&Rename Mask Editor.
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Notes about Unicode support 

Tag&Rename fully supports Unicode (tags, file names, drag and drop, etc.) on Windows 2000, XP, 2003 
and Vista systems.
All tag standards except ID3v1, ID3v2 and APEv1 always save data in Unicode. ID3v1 and APEv1 tags 
don't support Unicode at all. ID3v2 tags can optionally save Unicode data.

If you have problems with saving Unicode data into mp3 (ID3v2 tags) files, please check the Write 
Unicode data into ID3v2 tags option. This option must be checked to save this way.

 

Tag&Rename Tags options.

If you can't see Unicode data in the Tag&Rename file list, then be sure that the font currently being used 
by Tag&Rename supports Unicode data. You may need to change the Tag&Rename font in Program 
Options -> General.
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Tag&Rename General options.
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Running Tag&Rename on Virtual PC

Tag&Rename uses a third-party protection system which does not allow it to run normally on a Mac using 
Virtual PC.
Note that the following instructions are from the protection system developers. 
Tag&Rename developers do not have access to a Mac and Virtual PC and cannot verify this.

If you have problems with saving Unicode data into mp3 (ID3v2 tags) files, please check the Write 
Unicode data into ID3v2 tags option. This option must be checked to save this way.

VPC from Microsoft is a Virtual PC on an Apple Macintosh. Using version 6.1 or greater on top of OS X, 
you need to do some things before installing or using Tag&Rename because VPC precompiles code to 
make the PC session run faster. This is not compatible with Tag&Rename.

To allow Tag&Rename to run correctly you need to do the following:

- Start the Virtual PC session as normal.
- In the Mac Finder, navigate to the 'Documents' folder in your 'Home' folder. Open the 'Virtual PC 
Scripts' folder.
- Open the 'Toggle Compatibility Mode' script by double clicking it.
- The script opens in Script Editor.
- Click the 'Run' button at the top of the script window.
- Click 'OK' to the informational dialog that appears.
- Click 'Enable' in the next dialog.
- Return to the PC session, which is now running in compatibility mode and will be slower, and run 
Tag&Rename as normal.
- When complete, close the program and return the Virtual PC to normal mode by re-running the script 
above and selecting 'Disable' at the appropriate time.
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Tag&Rename keyboard shortcuts

Main window shortcuts

F1 Program help

F2 Edit file or folder name

F4 Switch to rename files mode

Ctrl+F4 Switch to multi file tag editor

Shift+F4 Switch to get tag from file name mode

F5 Edit file tag

Ctrl+F5 Edit file tag in selected files 

F7 Rename current folder

F8 Show/hide options bar

Ctrl + F8 Show/hide folders tree

F9 Get album titles from freedb

F10 Get album titles from amazon.com

F11 Start Tags Synchronization Wizard

F12 Start Export Wizard

Ctrl + A Select all files in file list

Ctrl + N Select no files in file list

Ctrl + I Invert files selection

Ctrl + Alt + A Select all highlighted files in file list (only if Use check boxes to 
select files option enabled) 

Ctrl + Alt + N Unselect highlighted files in file list (only if Use check boxes to select 
files option enabled) 

Ctrl + O Open new folder
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Ctrl + Alt + R Refresh folders tree

Ctrl + R Refresh file list 

Ctrl + F Search text in file list 

Ctrl + P Play current file

Ctrl + S Play selected files

Ctrl + T Auto Fill Track #

Del Delete file(s)/folder(s)

Shift + Ctrl + C Copy tag from current file to clipboard

Shift + Ctrl + V Paste tag to current file from clipboard

Ctrl + Alt + V Paste tag to selected files from clipboard

Ctrl + Alt + S Quick save selected files into playlist 

Ctrl + Alt + Q Quick save all files into playlist 

Ctrl + Alt + O Show program options dialog

gray + Select all files in file list

gray - Select no files in file list

gray * Invert files selection

Alt + 0 Switch to All mode

Alt + 2 Switch to ID3v2 mode

Alt + 3 Switch to Wma mode

Alt + 4 Switch to Ogg/Flac mode

Alt + 5 Switch to Mp4/M4a mode

Alt + 6 Switch to APEv2 mode
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File list shortcuts with highlighted folder 

Shift + Ins Select all files in current folder (only if Use check boxes to select 
files option enabled) 

Ctrl + Ins Select no files in current folder (only if Use check boxes to select 
files option enabled) 

Ctrl + Alt + F Open highlighted folder in file list

Ctrl + Alt + P Play files from highlighted folder

Ctrl + F9 Get album titles from freedb for files in highlighted folder

Ctrl + F10 Get album titles from amazon.com for files in highlighted folder

 

File list shortcuts with highlighted file

Del Delete file

Alt + Up Move file up

Alt + Down Move file down

Enter Edit file tag

Space Select current file (only if Use check boxes to select files option 
enabled) 

Insert Select file and insert next one (only if Use check boxes to select 
files option enabled) 

Ctrl + Alt + W Play current file in Winamp (Winamp2.x should be running)

Ctrl + Alt + Y Add current file to Winamp play list (Winamp2.x should be running)
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Tag&Rename configuration options

General

System options:
• Integrate Tag&Rename into shell – Determines whether the Tag&Rename Explorer context 

menu is enabled or not. 
• Don't close tag editor window on error – If Tag&Rename can't update a file tag, it will show 

an error message and won't close the editor window so you can try to save changes again. 
• Don't change file timestamp on saving tags – Enable this option if you don't want to 

change the modified file’s timestamp while editing tags. 
• Check for Tag&Rename updates automatically – Tag&Rename will inform you when a new 

version has been released. 
•      Also check for beta versions - with this option enabled you will also get info about new 

beta releases. 
• Capitalize options – Specify symbols after which the program capitalizes the next letter, when 

the capitalize function is activated. To set up a default symbols string, click the Set default 
button. 

• Interface font – Set the Tag&Rename interface font here (see also Unicode notes). 

Default start folder:
Specify whether Tag&Rename should open the last-accessed folder or some other fixed folder when the 
program starts.

File List

Files selection:
• Autoselect files when its folder selected - If this option enabled and Tag&Rename file list 

have folders in it, then folder selection will automatically select all files and folders in it. 
• Use check boxes to select files – When this option is disabled, file selection in the 

Tag&Rename file list works like in most programs: highlighted files = selected files. When this 
option is enabled, Tag&Rename shows checkboxes near file/folder names, and only checked files 
are selected. 

After open new folder:
Specify what Tag&Rename should do after it opens a folder.

• Auto expand all folders – Check this box if you want Tag&Rename to expand all subfolders in 
the playlist. 

• Files selection – Specify which files will be automatically selected after a folder is opened. 

View:
• Use colors – Check this option to see a colored file list. (Remember to select colors that you 

like.) 
• Color files with names longer than joliet standard – Check this box to see colored files 

with names longer than 64 characters (limitation of joliet CDR/CDRW standard). 
• Show lines – Enable/disable lines in file list. (Lines give the list a table-like appearance.) 
• Color files with low bitrate – Check this box to see colored files with a low bitrate. 
• Show ID3v1 tag is not present indicator - Show small red circle near file without ID3v1 tag 

(for mp3 and ape files only) 
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File List Columns

Columns – Specify which informational columns Tag&Rename shows in file list. Check the column(s) 
that you would like to be visible.

Players

If you don't want to use your default music player when playing files from Tag&Rename, you can change 
the default to a different player by clicking the button with the gray folder and browsing for the new 
player in the pop-up window. When you have located the player, double-click it and then click Open. The 
Winamp field is used to play mp3s from the Winamp control toolbar.
You will then see the directory path of your new player in the field next to the appropriate player. If you 
want to resume using your default player, simply clear the player field data.
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Web Import

Freedb connection settings:
• Freedb server – Host address of the freedb server. 
• Get servers list – Click this button to get a valid list of freedb servers. 
• Your e-mail – You must fill in your e-mail address to use freedb. 

Amazon.com import:
View file name options for cover art and review that you can save when importing information from 
amazon.com.

Proxy server:
If you are using a proxy server for your Internet connection, select its settings here.

Miscellaneous:
• Save track information from freedb and amazon.com in xx/xx format – Adds the total 

songs number to the tag track number field while importing. 
• Copy "Artist" data into "Album Artist" tag field while importing – This option is strongly 

recommended if you are using Windows Media Player or Windows Media Center Edition because 
of the widespread use of the Album Artist field in its Media Library (see screen shot). 

 

Windows Media Player with Media Library albums view. (You can see album artist in this view only if file 
tags have the Album Artist field filled.)
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Playlists

Options:
• Default playlist name – Default file name that appears in the "Save files to playlist" dialog box 

when using the "save all" or "save selected" files to playlist commands. 
• Add EXTINF information into playlist – Check to create extended m3u playlists (if you use 

Winamp or other player that supports EXTINF). 
• Save full file path into playlist 

Quick save playlist:
• "Selected" and "all" playlist name – Select and type in a name for the playlist Quick save 

options. You may use any text and/or variables listed at the bottom of the window. 
• Playlist folder – Specify a folder where Tag&Rename will save all your playlists. 
• Show save message – See the "Play list saved" confirmation pop-up window each time you do 

a Quick save playlist. 

File Rename Strings

Word replacements:
Specify the words or letters that will be automatically replaced during file renaming.

Note: The Word replacements function is not case-sensitive.

Always keep case of these words:
Fill this table with words whose case must remain as you specify here.

Note: This option works only if you use Case in the Capitalize First Letter or Capitalize first word 
mode.
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Tags

Tags options:
• Write Unicode data into ID3v2 tags - Note that some software does not support Unicode 

data in ID3v2 tags (some versions of Winamp, for example). 
• Calculate padding size automatically - When Tag&Rename creates an ID3v2 tag, it will 

calculate the padding automatically (recommended). 
• ID3v2 tag padding size in kb - Set the padding size for all files (only recommended for 

advanced users). 
• Auto copy "Artist" data into "Album Artist" tag field if it is clear – Enable if you are using 

Windows Media Player. 
• Set "Album Artist" to "Various Artists" when "Part of a compilation" checked – Enable 

if you are using Windows Media Player. 

Advanced

User interface:
• Save tag "Comment" and "Encoded by" fields – Save these fields upon exiting 

Tag&Rename. 
• Save focused field on "Save and next" – When enabled, if you edit a file tag and click the 

Save and next button, Tag&Rename will show the tag of the next file and place the cursor in the 
last edited field. Otherwise, the cursor will be placed in the Title field. 

• DJ style tag editor window – Exchange "URL" and "Encoded by" with "Label" and "Remixed 
by" in editor’s first tab. 

• Show file list tree lines 
• Don't show splash screen on program startup 
• Use Vista style files selection in files list - With this option enabled, selected files and 

mechanism of files selection looks like in Windows Vista Explorer 

Tags:
• Mark cover art as "Cover front" in ID3v2 tags 
• Delete ID3v1 tag when deleting ID3v2 tag – Automatically delete ID3v1 tag on ID3v2 tag 

deletion. 
• On saving ID3v2 tag – Select what to do with an ID3v1 tag while changing an ID3v2 tag. 
• On saving APE tag – Select what to do an with ID3v1 tag while changing an APE tag. 
• Don't update comment field when auto updating ID3v1 tags – Don't update an ID3v1 

comment field when Auto updating an ID3v1 tag after changing an ID3v2 or APE tag. 

Playlists:
• Save playlists in .m3u8 (UTF8 encoded format) – Save all playlists in .m3u8 format instead 

of .m3u format. 

Quick save playlist:
• Case – Setup playlist name case options. 
• Replace spaces by underscores – Select to generate playlist names like Artist_-_Album.m3u 
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License and warranty

License agreement:

You should carefully read the following terms and conditions before using this software. 

Registered version:

One registered copy of Tag&Rename may either be used by a single person who uses the software 
personally on one or more computers, or installed on a single workstation used non-simultaneously by 
multiple people, but not both. 

Evaluation and registration:

This is not free software. Subject to the terms below, you are hereby licensed to use this software for 
evaluation purposes without charge for a period of 30 days. If you use this software after the 30-day 
evaluation period a registration fee of $29.95 is required. When payment is received you will be sent an 
unlock key for the latest version of Tag&Rename. 

Unregistered use of Tag&Rename after the 30-day evaluation period is in violation of U.S. and 
international copyright laws. 

Disclaimer of warranty:

THIS SOFTWARE AND THE ACCOMPANYING FILES ARE SOLD "AS IS" AND WITHOUT WARRANTIES AS 
TO PERFORMANCE OR MERCHANTABILITY OR ANY OTHER WARRANTIES WHETHER EXPRESSED OR 
IMPLIED. 

Distribution of evaluation version:

Provided that you verify that you are distributing the evaluation version (select About from the 
Tag&Rename main menu to verify), you are hereby licensed to make as many copies of the evaluation 
version of this software and documentation as you wish; give exact copies of the original evaluation 
version to anyone; and distribute the evaluation version of the software and documentation in its 
unmodified form via electronic means. There is no charge for any of the above.

You are specifically prohibited from charging, or requesting donations, for any such copies, however 
made; and from distributing the software and/or documentation with other products (commercial or 
otherwise) without prior written permission. 
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Order Tag&Rename

Trial versions of Tag&Rename have limitations: a nag screen and 30-day trial period. 

If you decide to keep Tag&Rename thereafter, you must register and pay the registration fee of $29.95. 
Registration benefits are no nag screen at startup, FREE upgrades to all new 3.x versions, and product 
notification by e-mail. 

How to order:

You can order your copy of Tag&Rename for only $29.95 using one of the following: 

1. Through the World Wide Web. This is the fastest and easiest way. The ordering page is on a 
secure Netscape Commerce Server, ensuring that your information remains confidential. For 
details on ordering Tag&Rename through the Web, please go to the Tag&Rename register page 
at: http://www.softpointer.com/tr_purchase.htm  and follow the link "Order the Fully Licensed 
version of Tag&Rename". After completing the order, you will receive registration information 
immediately. 

2. If you don't have convenient Web access, you may order Tag&Rename by fax (also using a credit 
card) or phone (toll-free). In addition, you can use cheque or money order. The order form, fax 
and phone numbers, and mailing address are in the file "OrderForm.txt" included with 
Tag&Rename. 

Upon payment approval (usually one or two business days), we will send you the registration key which 
will remove all limitations of the unregistered version such as nag screens and 30-day trial period. Your 
registration will be valid for all future 3.x versions of Tag&Rename. 

Important: When filling out the order form, please double-check that your e-mail address is correct. If 
it is not, we will be unable to send you the registration code. 
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Technical support

Before you contact us, please do the following: 

• Be sure that you have followed procedures as described. We all make mistakes sometimes. 
Recheck what you have done or tried. 

• Look at the Help file. It may already contain an answer to your question. 
• Visit the Tag&Rename home page at http://www.softpointer.com/tr.htm. You may find a newer 

version of Tag&Rename there. If a serious bug has been found in the program, but the new 
version is not ready yet, we may make a quick fix for it. 

If you still have a problem with Tag&Rename, please contact technical support via e-mail at: 

tag-rename@softpointer.com 

Please provide us with the following: 

• Tag&Rename version (from the "About" menu item dialog) 
• Tag&Rename serial number (if you're a registered user) 
• Windows version (including service packs and other fixes installed) 
• Computer information: CPU type and speed, installed memory 
• Description of your problem (as much information as possible to help us reproduce the problem) 
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Tag&Rename FAQ

Functionality:

Is it possible to add a graphics file to more than one file? 

• Yes. You need to select the files in the Tag&Rename file list (according to "Use easy files 
selection" option settings) and click the "Edit all supported tag fields" button in "Multi file tag 
editor" tab. In the opened window, you can change any tag frame (including cover) in this group 
of files. 

Can Tag&Rename tag files (Artist, Album, Title) based on the file path? For example I have 
the following folders structure: <ARTIST>\<ALBUM>\<Track - Title>.

• Yes. Using your example (<ARTIST>\<ALBUM>\<Track – Title>) you need to use this file name 
mask: %1\%3\%6 %2 

In Windows Media Player 10 there is a tag called "Album Artist". This tag is very vital when 
you are using Windows XP Media Center 2005. You can set the tag in WMP10, but I cannot 
find it in Tag & Rename. Where is it?

• You can find this tag field in the Tag&Rename Tag Editor window’s "Additional" tab. Also see the 
"Copy "Artist" data into "Album Artist" tag field while importing" option in "Program options" -> 
"Web Import", and the "Auto copy "Artist" data into "Album Artist" tag field if it is clear" in 
"Program options" -> "Tags". 

Can I convert ID3v2 tags in my files to Unicode with Tag&Rename?

• Yes. See the "Program options" -> "Tags" -> "Write Unicode data into ID3v2 tags" option. To 
convert existing tags to Unicode (or to plain text), select the file(s) in the Tag&Rename file list 
and click the "Save Tags" button in "Multi files tag editor" tab with all its checkboxes unchecked. 
This will resave tags without changing their data according to the "Write Unicode data into ID3v2 
tags" option settings. 

Why can’t I submit CD information to freedb in Tag&Rename? 

• Since Tag&Rename loads freedb information without an original CD, it calculates the freedb disc 
id from music files. The calculated id is only an approximation which is close enough for finding 
album info. For submission, you need to have the original audio CD, so you should use software 
audio CD players or CD rippers for freedb submissions. 

What is portable mode? 

• In portable mode Tag&Rename store all settings in it folder and don't use system registry. So 
you can run portable Tag&Rename from flash drive on different computers without installing it.

44



Tag&Rename 3.5 User Manual – March 1, 2009

Problems:

I ran Tag&Rename, but none of the "Tools" program features are functioning. They’re all 
grayed. How do I enable them? 

• First select files (according to "Use easy files selection" option settings) in the Tag&Rename file 
list for which you want to do some "Tools" operation. Then all the functions will be enabled 
automatically. 

When I run Tag&Rename, it shows a splash screen and then closes without showing any 
error message. What can I do? 

• Tag&Rename cannot run on Windows XP SP2/2003 systems with enabled DEP (Data Execution 
Protection) and processors with hardware DEP support. To run Tag&Rename on such systems 
you first need to disable DEP. 

After I edit mp3 file tags with Tag&Rename some programs can't show this tag at all or 
show it incorrectly. (Tag&Rename shows tag data ok.) What can I do? 

• Most likely these programs can't read Unicode tags. See Tag&Rename options -> "Tags" -> 
"Write Unicode data into ID3v2 tags" and uncheck this option. To resave tags without Unicode, 
select files in the Tag&Rename file list and click the "Save tags" button on the "Multi file tag 
editor" tab. This will rewrite tags and remove Unicode data from them. (See also the "Notes 
about Unicode support" topic in program help.) 

I try to use Tag&Rename with files which contain Unicode data in file names and tags. 
However, when I looked at this files, Tag&Rename only displays the pipe symbol, e.g. ||||| 
|||||| |||||.mp3. Any suggestions?

• The font used in Tag&Rename doesn't have characters for this language, so go to "Program 
options" -> "General" -> "Interface font" and change it to a font which supports this language. If 
you have MS Office installed, then change it to "Arial Unicode MS". This font has support for most 
languages. 

I changed tags in my mp3/m4a files using Tag&Rename, but it seems that iTunes doesn't 
support these changes. In iTunes I still see old information. Why?

• iTunes has its own database and looks into file tags only when you add it to iTunes and play this 
file, so it will update tag changes while playing. Optionally, you can do the following: 

1. In iTunes, select all your files. 
2. Right click on them and select "Get Info". (This will open iTunes multi file tag editor.) 
3. Don't check any checkboxes or change anything - just click the "Ok" button and iTunes 

will reread tags from selected files. 

Why is it that when I change the MP3 tags, they don't change in Windows Media Player? 

• You need to update Media Player's "Media Library": 
1. Go to Media Player main menu -> "Tools" -> "Search for media files...". 
2. In search options, select a folder with your music files and "Never files and all existing 

files in library". 
3. Click the "Search" button. 

I renamed some songs in Tag&Rename but it changed their names back after a few minutes 
of playing them through my media player. How I can keep the new names for this files? 

• Most likely your files were renamed by your media player. 

• For Windows Media Player, go to the Media Player main menu -> "Tools" -> "Options" -> "Media 
Library" -> "Automatic media information updates for files" -> "Rename and rearrange music 
using media information" checkbox and uncheck it, if it is checked. 
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• For iTunes, go to the main menu -> "Edit" -> "Preferences" -> "Advanced" -> "Keep iTunes 
music folder organized" checkbox and uncheck it, if it is checked. 

When I try to use amazon.com or freedb I get the following message: "Cannot resolve host, 
error 2". It happens even when I'm online. What can I do? 

• There may be two reasons: 
1. If you are using firewall software, be sure that it allows Tag&Rename to go to the 

Internet. 
2. If you are using a proxy server, you may need to set it up in "Program options" -> "Web 

import" -> "Proxy server". 

Each time I tag an album, my disk space is reduced by the size of the album as if it was 
copied or doubled or something. I want to erase those temp files. How can I do it? 

• Most likely this problem occurs because you have enabled Windows XP "System Restore" 
functions on the drive with your mp3 files. When you add ID3v2 tags to mp3 files the first time, 
Tag&Rename needs to rewrite all file data since an ID3v2 tag is placed at the beginning of the 
file. While doing this, Tag&Rename writes to a temporary file and overwrites the original file with 
it. A "System Restore" enabled Windows machine does not delete these files; it just moves them 
into the "System Volume Information" folder. You can disable "System Restore" functions in 
"Control Panel" -> "System" -> "System Restore" tab.
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